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Introduction

SoloStaff Emailer is a desktop email management application designed specifically for solo

staff and small nonprofit organizations. It helps you manage email subscribers, create

professional email campaigns, and track engagement—all from your local computer.

Key Features

Subscriber Management - Import, organize, and maintain contact lists with tags

Campaign Editor - Create email campaigns using professional templates

Segmentation - Group subscribers for targeted messaging

SendGrid Integration - Professional email delivery with analytics

SMTP Support - Use your existing email provider

Scheduling - Schedule campaigns for future delivery

Analytics Dashboard - Track opens, clicks, and engagement

GDPR Compliance - Consent tracking and unsubscribe management

System Requirements

Windows: Windows 10 or later
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macOS: macOS 11 (Big Sur) or later

Linux: Ubuntu 20.04+ or equivalent

Getting Started

First Launch

When you first launch SoloStaff Emailer, the Getting Started Wizard will guide you through

initial setup:

Database Location - Choose where to store your data (default location

recommended)

Email Provider - Configure SendGrid API or SMTP settings

Sender Information - Set up your organization details

Import Subscribers - Optionally import existing contacts

Application Layout

The main window consists of:

Navigation Panel (left side) - Switch between sections: 

Subscribers

Campaigns

Segments

Analytics

Settings

Main Content Area (center) - Displays the current section

Status Bar (bottom) - Shows subscriber count and status messages

Managing Subscribers

The Subscribers section is where you manage your email contacts.
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Subscribers View

Viewing Subscribers

The subscriber list displays:

Column Description

Email Subscriber’s email address

Name Subscriber’s display name

Consent Checkmark indicates consent given

Opt-in Date Date subscriber gave consent

Use the Search box to find subscribers by email or name.

Adding Subscribers

Click the + Add button

Enter the subscriber’s email address (required)

Enter the subscriber’s name (required)

Select tags to categorize the subscriber

Check “Subscriber has given consent” if applicable

Set the opt-in date

Click Save

1. 

2. 

3. 

4. 

5. 

6. 

7. 



Editing Subscribers

Add Subscriber

Select a subscriber in the list

Click the Edit button (or double-click the subscriber)

Modify the subscriber’s information: 

Email address

Name

Tags (click tags to toggle selection)

Consent status

Opt-in date

Click Save to confirm changes

Deleting Subscribers

Select one or more subscribers

Click the Delete button

Confirm the deletion

Note: Deleted subscribers cannot be recovered.
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Importing Subscribers

To import subscribers from a CSV file:

Go to File > Import Subscribers (or press Ctrl+I)

Select your CSV file

Map columns to subscriber fields: 

Email (required)

Name

Tags

Consent status

Preview the import

Click Import to add subscribers

Exporting Subscribers

Click the Export button

Choose a location and filename

The CSV file will include all subscriber data

Working with Tags

Tags help you organize and categorize subscribers for targeted campaigns.

Manage Tags
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Opening Tag Manager

Go to Tools > Manage Tags to open the tag management dialog.

Creating Tags

Click + Add Tag

Enter a tag name (e.g., “donor”, “volunteer”, “newsletter”)

Optionally add a description

Choose a color for visual identification

Click Save

Editing Tags

Select a tag in the list

Click Edit

Modify the name, description, or color

Click Save

Deleting Tags

Select a tag

Click Delete

Confirm deletion

Note: The “Usage” column shows how many subscribers have each tag. Tags in use will

remain on existing subscribers after deletion.

Assigning Tags to Subscribers

When editing a subscriber, click on tag chips to toggle them: - Highlighted tags (blue) are

assigned to the subscriber - Gray tags are not assigned - Click + Add New Tag to create a

new tag while editing

Creating Segments

Segments let you group subscribers based on criteria like email domain, consent status, or

tags.
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Segments View

Creating a New Segment

Go to the Segments section

Click + New Segment

New Segment Dialog

Enter a Name for the segment (e.g., “Gmail Users”, “VIP Donors”)

Enter an optional Description

Configure Rules: 

Choose a field (Email, Name, Tags, Consent, etc.)

Choose an operator (contains, equals, starts with, etc.)

Enter a value

Add more rules with + Add Rule
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Choose rule matching: 

ALL rules match (AND) - Subscriber must match every rule

ANY rule matches (OR) - Subscriber must match at least one rule

Click Preview Matches to see matching subscribers

Click Save

Segment Examples

Segment Name Rule Description

Gmail Users Email contains “@gmail.com” All Gmail subscribers

Donors Tags contains “donor” All donors

Recent Subscribers Opt-in Date is after [date] New subscribers

Consented Consent equals “Yes” Subscribers with consent

Editing Segments

Select a segment

Click Edit

Modify rules or settings

Click Save

Deleting Segments

Select a segment

Click Delete

Confirm deletion

Creating and Sending Campaigns

Campaigns are the emails you send to your subscribers.

5. 

◦ 

◦ 

6. 

7. 

1. 

2. 

3. 

4. 

1. 

2. 

3. 



Campaigns View

Campaign Statuses

Status Color Description

Draft Gray Not yet sent or scheduled

Scheduled Blue Scheduled for future delivery

Sending Orange Currently being sent

Sent Green Successfully delivered

Failed Red Delivery failed

Creating a New Campaign

Click + New Campaign to open the campaign wizard.



Step 1: Choose Template

Choose Template

Browse available templates by category: 

Update - General announcements

Newsletter - Regular newsletters

Announcement - Important notices

Alert - Urgent messages

Appeal - Donation requests

Event - Event invitations

Thank You - Appreciation messages

Welcome - New subscriber welcomes

Click a template to preview it

Click Use Template to select it
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Step 2: Campaign Details

Campaign Details

Fill in your campaign information:

Campaign Information - Campaign Name - Internal name (not shown to recipients) - Email

Subject - Subject line recipients will see

Sender Information - From Name - Sender’s display name - From Email - Sender’s email

address

Template Content - Button Text - Text for call-to-action button - Button URL - Link for the

button - Main Content - Your email body text

Auto-Filled Fields These fields are automatically personalized: - {{first_name}}  -

Subscriber’s first name - {{organization_name}}  - Your organization name - 

{{organization_address}}  - Your address - {{unsubscribe_links}}  - Unsubscribe

link (required)

Click Refresh Preview to see your changes in the email preview.



Step 3: Select Recipients

Select Recipients

Choose who receives the campaign:

All Active Subscribers - Send to everyone with consent

Specific Segment - Send to a segment you created

The Summary shows how many subscribers will receive the campaign.

Sending Options

After completing all steps, you have three options:

Button Action

Save as Draft Save for later editing

Schedule Set a future date/time to send

Send Now Send immediately

Managing Campaigns

From the Campaigns view:

Edit - Modify a draft campaign

Schedule - Set send date for a draft

Send Now - Send a draft immediately
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Delete - Remove a campaign

Refresh - Update the campaign list

Filtering Campaigns

Use the Status dropdown to filter by: - All Campaigns - Drafts - Scheduled - Sending - Sent -

Failed

Use the Search box to find campaigns by name.

Analytics Dashboard

Track your email campaign performance in the Analytics section.

Analytics Dashboard

Metrics Overview

Metric Description

Total Subscribers Number of active subscribers

Active Campaigns Campaigns in progress or scheduled

Emails Sent Total emails sent in selected period

Avg Bounce Rate Percentage of undeliverable emails

Avg Open Rate Percentage of emails opened
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Metric Description

Avg Click Rate Percentage of links clicked

Date Range

Use the From and To date pickers to select a time period, then click Refresh.

Syncing Events

Click Sync Events to fetch the latest tracking data from your email provider (SendGrid).

Note: Event syncing requires SendGrid with tracking enabled.

Settings and Configuration

The Settings section has three tabs for configuring the application.

Email Provider Tab

Email Provider Settings

SendGrid Configuration

Select SendGrid as your active provider

Enter your API Key (starts with “SG.”)

Click Test Connection to verify

Status shows: Connected with tracking features enabled
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SMTP Configuration

Select SMTP (Generic) as your active provider

Enter your SMTP settings: 

SMTP Host (e.g., smtp.gmail.com)

SMTP Port (typically 587 for TLS)

Use TLS encryption (recommended)

Username

Password

Click Test Connection to verify

Unsubscribe Method

Choose how unsubscribes are handled: - SendGrid Tracking - SendGrid manages

unsubscribes automatically - Email Request - Recipients send an email to unsubscribe

Sender Info Tab

Sender Info Settings

Organization

Organization Name - Your nonprofit’s name

Organization Address - Physical address (required for compliance)

Sender Identity

From Name - Default sender name

From Email - Default sender email

Reply-To Email - Where replies are sent (optional)
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The Email Header Preview shows how your sender information will appear.

Preferences Tab

Configure application behavior: - Theme settings - Default values - Notification preferences

Saving Settings

Click Save Settings to apply changes. The status bar shows “Unsaved changes” when

modifications are pending.

Keyboard Shortcuts

Shortcut Action

Ctrl+N New campaign

Ctrl+I Import subscribers

Ctrl+E Export subscribers

Ctrl+F Focus search box

Ctrl+S Save (in dialogs)

Escape Cancel/Close dialog

F1 Open help

F5 Refresh current view

Troubleshooting

Application Won’t Start

Ensure your system meets the minimum requirements

Try running as administrator (Windows) or with sudo (Linux)

Check for error messages in the console

SendGrid Connection Failed

Verify your API key is correct

Ensure the key has “Mail Send” permission

Check your internet connection
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Try generating a new API key

SMTP Connection Failed

Verify host, port, and credentials

Ensure TLS is enabled if required

For Gmail: Enable “Less secure app access” or use App Password

Check firewall settings

Emails Not Sending

Verify email provider is configured and tested

Check campaign status for error messages

Ensure subscribers have consent

Review SendGrid activity for bounces

Import Failing

Ensure CSV file is properly formatted

Check for special characters in email addresses

Verify column mapping is correct

Try a smaller test import first

Credential Storage

The status badge in Settings shows your credential storage method:

Status Color Description

Secure storage active Green Using OS keyring

File storage active Blue Using encrypted file

Temporary storage Orange Memory only (not persistent)

Getting Help

Built-in Help

Access the inline user guide: Help > User Guide (or press F1)
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Inline User Guide

Report Issues

If you encounter bugs or have feature requests:

Go to: https://github.com/StephenBogner/solostaff-emailer-application/issues

Click “New Issue”

Describe the problem with steps to reproduce

Include your operating system and application version

Contact

For direct support, contact the developer through the GitHub repository.

Personalization Tokens Reference

SoloStaff Emailer uses handlebar tokens (also called merge tags) to personalize emails.

Tokens are placeholders in the format {{token_name}}  that get replaced with actual values

when emails are sent.
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How Tokens Work

When you create a campaign: 1. System tokens are automatically filled from subscriber

data and your settings 2. Content tokens are fields you fill in when creating the campaign 3.

When the email is sent, all tokens are replaced with actual values

System Tokens (Auto-Filled)

These tokens are automatically populated from subscriber data and your organization

settings. You don’t need to enter values for these—they’re filled in for each recipient.

Token Description Example Output

{{first_name}}

Subscriber’s first

name (extracted from

full name)

“Jane”

{{last_name}}
Subscriber’s last

name
“Doe”

{{name}} Subscriber’s full name “Jane Doe”

{{email}}
Subscriber’s email

address
“jane.doe@example.com”

{{organization_name}}
Your organization

name (from Settings)
“Local Nonprofit”

{{organization_address}}

Your organization

address (from

Settings)

“123 Main St, Anytown, CA”

{{unsubscribe_url}}
Direct unsubscribe

link URL
https://...

{{preferences_url}}
Email preferences

page URL
https://...

{{unsubscribe_links}}

Complete HTML block

with unsubscribe/

preferences links

[Unsubscribe] | [Preferences]

{{year}} Current year “2025”

{{month}} Current month name “December”



Token Description Example Output

{{day}} Current day of month “27”

Content Tokens (User-Editable)

These tokens appear as form fields when you create a campaign. Fill them in to customize

your email content.

Campaign Information

Token Description Input Type

{{subject_line}}
Email subject (for blank

templates)
Single line

{{preview_text}} Preview text shown in inbox Single line

{{headline}} Main headline text Single line

{{subheadline}} Secondary headline Single line

Sender Information

Token Description Input Type

{{sender_name}} Name of the person sending Single line

{{sender_title}} Title/role of sender Single line

Main Content

Token Description Input Type

{{main_content}} Primary email body content Multi-line

{{intro_paragraph}} Opening paragraph Multi-line

{{closing_paragraph}} Closing paragraph Multi-line

{{closing_message}} Brief closing message Multi-line

{{custom_content}}
Free-form HTML content

(blank templates)
Multi-line



Buttons and Links

Token Description Input Type

{{button_text}} Call-to-action button label Single line

{{button_url}} Button destination URL Single line

{{featured_link}} Link for featured content Single line

Appeal/Fundraising Templates

Token Description Input Type

{{appeal_headline}} Fundraising appeal headline Single line

{{appeal_subheadline}} Appeal secondary text Single line

{{story_paragraph}} Impact story content Multi-line

{{fundraising_goal}}
Target amount (e.g.,

“$10,000”)
Single line

{{amount_raised}} Amount raised so far Single line

{{goal_amount}} Goal amount for progress bar Single line

{{progress_percent}} Progress percentage (0-100) Single line

{{impact_message}} How donations help Multi-line

{{donate_link_other}}
Link for custom donation

amount
Single line

Year-End Giving Templates

Token Description Input Type

{{days_remaining}} Days until deadline Single line

{{deadline}} Deadline date Single line

{{year_end_message}} Year-end appeal content Multi-line

{{ein_number}} Organization EIN for tax receipts Single line



Event Templates

Token Description Input Type

{{event_name}} Name of the event Single line

{{event_date}} Event date Single line

{{event_time}} Event start time Single line

{{event_location}} Venue name Single line

{{event_address}} Venue address Single line

{{dress_code}} Dress code information Single line

{{invitation_message}} Event description Multi-line

{{additional_info}} Extra event details Multi-line

{{rsvp_deadline}} RSVP due date Single line

{{rsvp_accept_url}} RSVP acceptance link Single line

{{rsvp_decline_url}} RSVP decline link Single line

{{time_until_event}}
Time remaining (e.g., “3

days”)
Single line

{{what_to_bring}} Items to bring Multi-line

{{contact_email}} Contact email for questions Single line

Thank You/Receipt Templates

Token Description Input Type

{{donation_amount}} Donation amount received Single line

{{donation_date}} Date of donation Single line

{{transaction_id}} Transaction reference number Single line

{{share_facebook}} Facebook share link Single line

{{share_twitter}} Twitter/X share link Single line



Token Description Input Type

{{share_linkedin}} LinkedIn share link Single line

Announcement/Alert Templates

Token Description Input Type

{{announcement_title}} Announcement headline Single line

{{announcement_body}} Announcement content Multi-line

{{alert_title}} Alert headline Single line

{{alert_subject}} Alert subject for email Single line

{{alert_message}} Alert body content Multi-line

{{action_required}} Required actions Multi-line

Newsletter Templates

Token Description Input Type

{{newsletter_tagline}} Newsletter tagline/slogan Single line

{{featured_title}} Featured article title Single line

{{featured_content}} Featured article content Multi-line

{{article1_excerpt}} First article excerpt Multi-line

{{article2_excerpt}} Second article excerpt Multi-line

Creating Custom Templates

You can create custom email templates using HTML and the token system described above.

Using the Blank Templates

SoloStaff Emailer includes two blank templates for custom content:

Blank - Custom HTML - Full control with header and footer

Blank - Minimal - Maximum flexibility, minimal structure
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These templates accept the {{custom_content}}  token where you can paste your own

HTML.

Writing Custom HTML

When creating custom content, you can:

Paste from Word/Google Docs - Copy formatted text and paste into the content field

Write HTML directly - Use standard HTML tags for formatting

Export from Markdown - Convert Markdown to HTML and paste

Basic HTML Examples

Template Best Practices

1. Always Include Required Tokens

Every template should include: - {{unsubscribe_links}}  or {{unsubscribe_url}}  -

Required for CAN-SPAM compliance - {{organization_name}}  - Identifies your

organization - {{organization_address}}  - Required physical address

2. Use Personalization Thoughtfully

Use {{first_name}}  in greetings: “Dear {{first_name}},”

Provide fallbacks mentally - some subscribers may not have names set

Don’t over-personalize - it can feel intrusive
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<!-- Paragraph with bold text -->

<p>Thank you for your <strong>generous support</strong> this year!</p>

<!-- Bulleted list -->

<ul>

<li>Item one</li>

<li>Item two</li>

<li>Item three</li>

</ul>

<!-- Link -->

<p>Visit our <a href="https://example.com">website</a> for more 
information.</p>

<!-- Image (use absolute URLs) -->

<img src="https://example.com/image.jpg" alt="Description" width="600">

• 

• 

• 



3. Keep Emails Mobile-Friendly

Use single-column layouts

Keep text readable (14-16px minimum)

Make buttons large enough to tap (44px minimum height)

Test on mobile devices

4. Optimize Images

Host images on reliable servers (or use built-in image embedding)

Always include alt  text for accessibility

Keep total email size under 100KB when possible

Template Token Syntax

Tokens must follow this exact format:

{{token_name}}

Rules: - Use double curly braces: {{  and }}  - Token names use lowercase letters and

underscores only - No spaces inside the braces - Tokens are case-sensitive

Correct: {{first_name}} , {{organization_name}}

Incorrect: {{ first_name }} , {{FirstName}} , {first_name}

Testing Your Templates

Before sending to your list:

Preview - Use the preview panel to see how tokens render

Test Send - Send a test email to yourself

Check Links - Verify all URLs work correctly

Mobile Test - View on a phone or tablet

Spam Check - Avoid spam trigger words

Email Client Compatibility

Different email clients render HTML differently. For best results:

Do Don’t

Use inline CSS styles Use external stylesheets

Use <table>  for layouts Use CSS flexbox/grid
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Do Don’t

Use web-safe fonts Use custom fonts

Use absolute image URLs Use relative paths

Test in multiple clients Assume one client = all

Embedding Images

SoloStaff Emailer supports two methods for images:

External URLs - Link to images hosted elsewhere

Embedded Images - Use the Insert Image button in the campaign editor to embed

images directly in the email (increases email size but ensures display)

SoloStaff Emailer v0.8.0-beta

Copyright 2025 Stephen Bogner, P.Eng. All Rights Reserved.

For the latest version and updates, visit: https://github.com/StephenBogner/solostaff-emailer-

application
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